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1. Background
The African Climate Policy Centre (ACPC) is the secretariat of the Climate for Development in Africa 
(ClimDev-Africa) programme, which is a joint initiative of the Economic Commission for Africa, the African 
Union Commission, and the African Development Bank. ACPC has developed a socioeconomic benefits 
framework that allows stakeholders to assess the impact of climate information services (CIS) on policy 
development and resource allocation processes. By expressing the outcomes, in terms of socioeconomic 
benefits, of CIS investments and application in monetary terms, the framework illustrates whether the 
benefits of policies outweigh the amount of money invested in them. In this way, it is easier for policy 
makers to justify ongoing or future investments in CIS.

The socioeconomic benefits framework outlines the steps that must be completed to identify and use 
indicators in support of an integrated sectoral analysis of the socioeconomic benefits stemming from CIS. 
Some of those steps are relevant to climate vulnerability assessments, while others are more relevant in 
adaptation and policy formulation/assessments. Those steps facilitate efforts to conduct an integrated 
cost-benefit analysis that takes into account relevant social, economic and environmental factors and 
expected policy outcomes. The cost-benefit analysis looks at three key components, namely investments, 
avoided costs and added benefits. It also provides for an economic evaluation of any environmental 
impacts.

Once a socioeconomic benefits framework has been formulated, it can be customized for specific sectors, 
starting with agriculture and disaster risk reduction. This tailoring of the framework to create specific 
models facilitates an in-depth analysis of the economic benefits of CIS at the sectoral level, thereby 
enabling decision-makers to draw up more appropriate strategies for averting climate-induced disasters 
or promoting economic growth.

Model outputs facilitate the integration of CIS information into disaster risk reduction initiatives, including 
the application of climate information and prediction systems to track potential hydro-meteorological 
hazards and avert potential weather- and climate-induced disasters. Model outputs also allow 
stakeholders to identify hydro-meteorological disaster patterns and advocate for appropriately climate-
resilient development, housing, roads, bridges, dams and other infrastructure.
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2. Vensim software platform
The socioeconomic benefits of CIS frameworks using systems dynamics was developed using Vensim 
software, designed by Ventana Systems Inc. The software allows users to conceptualize, document, 
simulate, analyse, and optimize models of complex dynamic systems. Vensim software provides a 
flexible approach to model creation and allows users to include ideas, build diagrams and create formal 
simulation models.

For advanced modelling, users should use the Vensim PLE Plus, Vensim DSS and Vensim Professional 
configurations, which allow for arrays in the equation editor. The Vensim Model Reader configuration can 
only be used to run models and cannot be used for model design. The Model Reader configuration can, 
however, be used to read arrays. 

Users can import models from other applications, and make use of the powerful analysis and optimization 
tools developed by Vensim. Modelling starts with causal loop diagrams, equations, or stock and flow 
diagrams. Below is an example of a causal loop diagram.

Figure 2.1 Causal loop diagram showing CIS coverage for a model CIS socioeconomic benefits 
framework

Cis Coverage
change in cis
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The diagram consists of:

(a). Rates, for example, the change in CIS coverage;

(b). Stock, for example CIS coverage;

(c). Variables, for example CIS adjustments.
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Causal loop diagrams show how variables in a Vensim model affect each other. An arrow going from A 
to B indicates that A causes B. Causal loop diagrams can be very helpful in conceptualizing and showing 
relationships among structures and processes. By connecting words with arrows, relationships among 
system variables are entered and recorded as causal connections. Causal loop diagrams can help users 
analyse models throughout the building process, understand the causes and uses of a variable and 
conceptualize the loops involving that variable.

The causal loop diagram shown in figure 2.1 shows that CIS adjustment is affected by the following 
variables:

(a). CIS investment policy switch;

(b). Desired CIS coverage;

(c). Time to establish CIS;

(d). Start time of CIS investment;

(e). Time (time step set for the model);

(f ). CIS coverage.

Furthermore, CIS adjustment affects the rate of change in CIS coverage. All the aforementioned variables 
are represented by equations. A variables equation is formulated by assessing the relationship among 
relevant variables.

For example:

(a). Rate of change in CIS coverage = CIS adjustment;

(b). CIS coverage = rate of change in CIS coverage, etc.;

(c). Fraction of gross domestic product (GDP) invested in CIS infrastructure and skills = if then else 
(Time > start time of CIS investment, 0.0005,0);

(d). Investment in CIS = real GDP * fraction of GDP invested in CIS infrastructure and skills;

(e). Desired CIS coverage = 1 (N.B. a constant assigned a value of 1);

(f ). Intervention effectiveness = impact of CIS coverage on intervention effectiveness table (CIS 
coverage), etc.

After a model has been successfully simulated, users can view different outputs by using the tools on the 
left side of the model to manipulate the output. Users can specify different types of outputs, including 
graphs, tables and tree diagrams. 

Tool bar glossary

(a). Ordinary window functions

(i). Mouse

Windows computers (PCs) have left and right mouse buttons, while Macintosh computers have only one 
mouse button. Vensim makes use of the left and right buttons on PCs as described below. Macintosh 
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users will need to use their mouse button and the Ctrl key or Apple key (for right button clicks) as 
described below.

Left button

The left button is used to perform almost all operations in Vensim, such as selecting a menu, clicking 
a button or dragging graphs or sketch objects. Whenever the manual requires a mouse click without 
mention of left or right, perform a click with the left button. Macintosh users should click the only button.

Right button

The right button is used to set options for sketch tools, analysis tools and sketch objects. It is also used for 
positioning and zooming in on sketches. When a right button click is required, click the right button on 
PCs. Macintosh users need to click the mouse button while holding down the Ctrl key or the Apple key 
(Ctrl + Click, or z + Click). To scroll a sketch, drag with the right mouse button or hold down the Ctrl key 
and drag with the left mouse button. To zoom, drag with the right mouse button while holding down 
the shift key.

Mouse wheel

On computers equipped with a mouse wheel, users can use the wheel to scroll windows up and down. 
For horizontal scrolling, hold down the shift key and move the mouse wheel. Holding down the control 
key allows users to zoom in and out of a sketch.

(ii). Title bar

At the top of the screen two important items are shown, namely the name of the model that is open and 
the workbench variable. The workbench variable is selected by clicking on Variable.

(iii). Status bar

This shows the state of the sketch and objects in the sketch. The status bar contains buttons for changing 
the state of selected objects, and moving to another view.

A number of sketch attributes can be controlled from the status bar, including: 

• Characteristics of selected variables such as font type, size, bold, italic, underline, strikethrough;

• Hide level;

• Colour, box colour, surround shape, text position, arrow colour, arrow width, and arrow polarity.

When using the Text Editor function in Vensim Professional and Vensim DSS configurations, the status bar 
changes to reflect text edition operations.

(iv). File

The File menu can be opened to see where files are located and allows for common functions, including 
Open Model, Save and Print. 

(v). Edit

The Edit menu allows users to copy and paste selected portions of a model and to search for model 
variables.
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(vi). View

Clicking on the View menu allows users to manipulate model sketches and to view models as text-only 
(available only in Vensim Professional and Vensim DSS configurations).

(vii). Layout

This allows users to manipulate the position and size of elements in a model sketch.

(viii). Model

The Model menu provides access to the Simulation Control and the Time Bounds dialogues, the model 
checking features, and importing and exporting data sets.

(ix). Tools

Clicking on the Tools tab allows users to set Vensim global options and allows users to manipulate analysis 

and sketch tools.

(x). Options

In Vensim PLE and PLE Plus configurations, an Options menu rather than a Tools menu is provided.

(xi). Windows

Clicking on the Windows menu allows users to toggle among different open model windows.

(xii). Help

The Help tab provides access to the online help portal.

(b). Model running functions

(xiii).New Model

Used to build a new model.

(xiv).Open Model

Used to open a model that is in progress or completely built.

(xv). Save

Used to save a partially built or finished model for future completion and/or reference/modification.

(xvi). Print

Used to print the model as a Microsoft Word document.

(xvii). Toolbar

The toolbar provides buttons for some of the most commonly used menu items and simulation features. 
The first set of buttons access certain File and Edit menu items, namely:

• Cut

• Copy
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• Paste

• Print

• Save

• Browse

(xviii).Runname

The Runname editing box is used for naming simulations, which can be viewed in data sets under the 
Control Panel window.

(xix). Sim Set-up

Used to toggle between Simulation and SyntheSim.

(xx). Simulation Results File Name (window)

(See Runname) 

(xxi). Simulate

Used to generate the different model outputs.

(xxii). SyntheSim

Each model constant has a slider that can be used to adjust values. Users can enter Sim Setup and 
SyntheSim mode by clicking on the associated icon in the toolbar.

(xxiii). Reality Check

Reality Check is run by first setting up a simulation and then testing one or more of the reality check 
equations entered by the user. Reality Check can be run from the toolbar or from the Simulation Control 
dialogue. Users make changes and adjust other options just as they can for a normal simulation before 
clicking on Reality Check in the Simulation Control dialogue or the relevant toolbar button.

Any changes made to constant values, data or other variables prior to launching Reality Check will remain 
valid throughout the Reality Check session.

(xxiv). Level

Levels are also known as stocks, accumulations, or state variables. Levels change their values by 
accumulating or integrating rates. This means that the values of levels change continuously over time, 
even when rates are changing discontinuously. Rates, also known as flows, change the value of levels. The 
value of a rate is not dependent on previous values of that rate. Instead, the levels in a system, along with 
exogenous influences, determine the values of rates. Intermediate concepts or calculations are known 
as auxiliaries and, like rates, can change immediately in response to changes in levels or exogenous 
influences. 

When constructing a Level and Rate Diagram, users should consider which variables accumulate over a 
period of time. Another way to think about this is to consider the following: if time slowed down to zero 
for your system, what variables would still be non-zero? For example, in the system where you pour water 
into a glass, the water contained in the glass is the level. If you froze time, the pouring (a rate) would stop, 
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but you would still see a quantity of water in the glass (a level). Once you know what levels you need, 
enter those first and then input the rates and auxiliaries. Model building tends to be iterative.

(xxv). Arrow

The arrow tools allow users to create links among variables. The Regular Arrow tool creates either a 
straight or curved (arc) link, the Polyline Arrow tool creates a series of line segments for the link, and the 
Perpendicular Arrow tool creates a series of perpendicular line segments for the link.

(xxvi). Rate

The Rate tool function contains both the Rate tool and the Valve tool. The Rate tools adds a complete rate 
(a valve, two arrows and clouds if necessary), while the Valve tool adds just the valve. Rates and valves are 
used to represent flows of materials into and out of levels.

To use the Rate tool, users click on the variable that they want to represent a flow out of, then move the 
mouse to the Level variable that they want to represent a flow into before clicking again.

(xxvii). Sketch

Sketch tools are grouped into the Sketch toolset. Although the Vensim PLE and Vensim PLE Plus 
configurations provide only a built-in Sketch toolset, the other configurations allow users to choose and 
modify Sketch toolsets by adding, moving and changing the actions of the different tools. Customized 
toolsets can be saved to files and reopened for later use. The built-in Sketch toolset (default.sts) contains 
most of the Sketch tools needed for building models. 

Vensim PLE and PLE Plus do not contain the Model Variable, Merge, Unhide Wand or Hide Wand tools. 

In the other configurations, the Sketch tools can be configured by clicking with the right mouse button 
on the Sketch tool and selecting one or more of the available options. If the configuration of a tool 
is changed, the user will be asked whether he or she wishes to save the Sketch toolset when exiting 
Vensim. Clicking “Yes” overwrites the old toolset. Clicking “No” keeps the old toolset (any changes made 
are not saved). Clicking “Cancel” allows the user to access the Tools menu to save the new toolset under 
a new name before exiting. There is no limit to the number of toolsets that can be saved, but most users 
find it convenient to use a single sketch toolset that has been configured to their particular needs.

The built-in Sketch toolset includes the following tools:

• Lock: the sketch is locked. The pointer can be used to select sketch objects and the workbench 
variable but cannot move sketch objects

• Move/Size: this moves, sizes and selects sketch objects, including variables and arrows

• Variable: this creates variables, including constants, auxiliaries and data

• Level: this creates variables within boxes (used to indicate levels)

• Arrow: this creates straight or curved arrows

• Rate: this creates rates, which consist of a variable, perpendicular arrows, a valve and, if 
necessary, sources and sinks

• Model Variable: this adds an existing model variable and the causes of that variable to the 
sketch view
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• Shadow Variable: this adds an existing model variable to the sketch view as a shadow variable 
(without adding its causes)

• Merge: this facilitates a number of operations, including the merging of two variables into a 
single variable, the merging of levels onto existing clouds, and the merging of arrows onto a 
variable

• Input Output Object: this adds input sliders and output graphs and tables to the sketch

• Sketch Comment: this allows users to add comments and pictures to the sketch

• Unhide Wand: this unhides (makes visible) variables in a sketch view

• Hide Wand: this hides variables in a sketch view

• Delete: this deletes structures, model variables and comments in a sketch

• Equations: this allows users to create and edit model equations using the equation editor

• Reference Modes: this is used to draw and edit reference modes.

(xxviii). Build Windows

The Build Windows function is used to create models in Vensim. By default, it opens with the Sketch 
tools so that the user can sketch the structure of the model and write equations. The status bar provides 
buttons for modifying the sketch. Models can be built in all configurations except the Vensim PLE 
configuration from several different sketches or sketch views. Each sketch view shows part of the model, 
much like each page in a book tells part of a story. In Vensim Professional and Vensim DSS, the Build 
Window function can be used as a text editor to build and edit text-based models. The status bar then 
switches to a text-editing version.

(xxix). Output windows

Output windows are generated by clicking on an analysis tool. The analysis tools gather information 
from the model and display that information in a window as a diagram, graph, or text, depending on the 
particular tool used. Dozens of output windows can remain open simultaneously. A particular window 
can be closed individually by clicking the Close button in the top left or top right corner of the screen, or 
all windows can be closed at once by selecting the Windows menu and clicking on the Close All Output 
button.

(xxx). Control Panel

The Control Panel allows users to change internal settings that govern the operation of Vensim, such 
as the selected workbench variable or the data sets used. The control panel groups the controls in six 
tabbed folders (five in Vensim PLE and in PLE Plus). Users can select a particular control by clicking on the 
appropriate tab at the top of the window. These include:

• Variable: this allows users to choose variables in a model and select the workbench variable

• Time Axis: this allows users to select or change the period of time over which analysis tools 
operate

• Scaling: this enables users to change the scales of output graphs

• Datasets: this allows users to manipulate stored data sets (runs)



Using Vensim simulation software to assess the socioeconomic impact of climate information services 

9

• Graphs: this brings up the Custom Graph Control

• Placeholders: this is a control that sets so-called “Placeholder Values” (this feature is not offered 
in the PLE or PLE Plus configurations).

(xxxi). Lock Sketch

This locks the mouse to sketching only.

(xxxii).Variable

This allows users to choose variables for a model and select the workbench variable.

(c). Graphical output function icons

(xxxiii). Causes Tree

This creates a tree-type graphical representation showing the causes of the workbench variable.

(xxxiv). Uses Tree 

This creates a tree-type graphical representation showing the uses of the workbench variable.

(xxxv). Loops

Clicking on this icon will display all the relationships that a workbench variable has to other variables and 

provide a list of all feedback loops passing through that workbench variable.

(xxxvi). Document

This icon allows the user to review equations, definitions, units of measure and selected values for the 

workbench variable.

(xxxvii). Document All

This icon allows the user to review equations, definitions, units of measure and selected values for all the 

variables of that particular model.

(xxxviii). Causes Strip

This displays simple graphs in a strip, allowing the user to trace causality by highlighting the direct causes 

of the workbench variable.

(xxxix). Graph

This icon displays behaviour in a larger graph than the Strip Graph, and offers different output options.

(xl). Table

Clicking on this icon will generate a table of values for the workbench variable.

(xli). Table Running Down

This generates a table with time running down.
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(xlii).Run Comparisons

This allows the user to compare all lookups and constants in an initial data set to those in a subsequent 

data set.

(c). Display of variables in a model

(xliii). View window

Large models can be presented more clearly in multiple views than in a single view. Views can be thought 
of as similar to pages of a book, each page telling a portion of the story. Each view displays a sketch and 
is connected to one (or more) of the other views through variables or shadow variables. Multiple views 

allow models to be broken down into sectors, such as financial, customer and production.

(d). Text Types

(xliv). Font types and other functions

The platform provides for various font types and other useful functions, including: bold; italics; underline; 
strike through; shape; colour on text; colour on box; set surround shape on variable; shape on box; colour 
on selected arrow; arrow width; polarity on selected arrow, and; push highlighted word to background.
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3. Motivation for the development 
of models to assess the 
socioeconomic impact of 
climate information services 
used in connection with disaster 
risk reduction initiatives

Setting the scene
Nearly all natural disasters in Africa are triggered by extreme climate system events, including droughts, 
floods, tropical cyclones and storms. Disasters occur when no adequate advance warning is given of 
impending extreme climate events, which disproportionately affect vulnerable communities. Support 
must be provided to States to facilitate their efforts to develop effective climate early warning systems 
and, in order to assess the impact of applying climate information services in connection with disaster 
risk reduction initiatives, models must be developed with a view to conducting cost-benefit analyses of 
interventions. The data generated by those models can guide policymakers in the area of disaster risk 
reduction.

Data sources and formats

Data to inform indicators related to disaster risk reduction 
and climate parameters are obtained from primary and 
secondary sources� These are conveniently formatted for 
processing�

Theoretical formulations
Computer modelling to assess the socioeconomic impact of climate information services used in 
connection with disaster risk reduction initiatives is an elaborate process and it is critical that simulations 
provide a realistic assessment of the potential impact of a range of policy interventions. 
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4. Model structure
The socioeconomic impact framework provides for range of sketches, each of which captures a specific 
element of the overall model, such as agriculture production, livestock numbers or healthcare. As 
illustrated in the screenshot shown in figure 4.1, the list of sectors included in the model can be accessed 
by clicking on a tab at the bottom left of the screen. To access the different sectoral sketches, the user 
clicks on the name of the relevant sector. In the screenshot, the user is accessing the “Disaster Risk 
Reduction Interface” sketch.

Figure 4.1 Overview of sectors in the CIS disaster risk reduction model

Climate impacts, and the impacts of disaster risk reduction interventions, are captured in the respective 
sketches where the impacts occur. All climate impacts and climate-related variables are highlighted in 
pink throughout the model. Figure 4.2 illustrates how the variables used to simulate climate impacts (in 
this case on productive agriculture land) are represented.
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Figure 4.2 Illustration of climate impacts 
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Climate impacts depend on precipitation values and the respective tables are derived from available 
data sets. The approach for calculating the parameters to capture climate impacts in the CIS disaster 
risk reduction model is outlined in the main report. Figure 4.3 shows the lookup function of the variable 
“Share of agriculture land affected by flood table” for illustration purposes.

Figure 4.3 Illustration of the graphic function used to simulate climate impacts on agriculture 
land

The lookup functions (or table functions) can be accessed by following the following steps:

(a). Click on the Equation tab above the sketch viewer and click on the variable of interest. A 
window will open that contains the values of the table as defined by the user;

(b). Click on “As Graph” in the equation editor to access the lookup function and obtain a graphical 
representation of the table function.
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These steps are illustrated visually in figure 4.4. In this case, the window illustrates the lookup function 
for the variable “Share of agriculture land affected by flood table”. Parameter values in the window can 
be edited, but this should only be done with extreme care: values are based on empirical data, and any 
changes made can have a significant impact on simulation results.

Figure 4.4 Accessing lookup functions in the CIS disaster risk reduction model
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5. Running scenarios
The current version of the model can be used to run the following four scenarios:

Business as usual

Climate

No climate

Climate information service investment
Policy switches in the “Disaster risk reduction interface” sketch are used to define the scenario to be 
simulated. A policy switch is a model variable that can be adjusted to “switch” impacts on and off. A policy 
switch is active if it has the value “1”, and inactive if it has the value “0”.

The following three steps must be followed to define the scenario to be simulated:

(a). Click on the Equation tab in the task bar;

(b). Open the equation editor of the policy switch that you want to edit;

(c). Change the value from “0” to “1” to activate a switch, and from “1” to “0” to deactivate a switch. 
After selecting the desired values, click on “Ok” in the bottom left of the window to save any 
changes made.

These steps are illustrated in figure 5.1, while table 5.1 shows how the switches must be set in order to 
simulate each of the four scenarios.

Figure 5.1 Defining a scenario
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Table 5.1 Switch settings for the four scenarios

Scenario Climate 
switch

Policy switch 
no climate

CIS investment 
policy switch Comments

Business as 
usual

0 0 0
Business as usual scenario, without climate 

impacts.

Climate 1 0 0
Business as usual scenario, with climate 

impacts and 30% CIS coverage assumed. 

No Climate 1 1 0
Reference scenario with the same 

parameterization as the CIS scenario, but 
without CIS coverage (0%). 

Climate 
information 

services
1 0 1

Policy scenario in which investments in CIS 
increase CIS coverage to a desired level (here 
100%), starting from 2020. Full coverage is 

reached around 2040. 
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6. Model simulations
The following steps must be taken to run a scenario:

(a). Enter a name for the relevant scenario under “Simulation results file name”. This is the name 
under which the scenario will be saved. The scenario will be saved in the same folder as the 
model.

(b). Click on “Simulate” to simulate the scenario. If the user accidentally forgets to change the file 
name before running a new scenario, the user will be asked if he or she wishes to overwrite the 
old simulation. To overwrite it, click on “Yes”. If not, change the file name first and then click on 
“Simulate” to run the scenario.

These steps are illustrated in figure 6�1�

Figure 6.1 Naming and running a scenario 
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7. Using the model to assess 
the socioeconomic impact of 
climate information services 
and examples of outputs

In addition to taking into account the theoretical steps outlined above; users must follow the steps 
outlined below in order to build and run a model. For advanced modelling, users should use the Vensim 
PLE Plus, Vensim DSS and Vensim Professional configurations, which allow for arrays in the equation 
editor. The Vensim Model Reader configuration can only be used to run models and cannot be used for 
model design. The Model Reader configuration can, however, be used to read arrays.

To start building a model, double click on the Vensim icon. A blank model will appear and prompt the 
user to set the time axis. The screen will appear as in figure 7.1.

Figure 7.1 Vensim model page after double clicking on the Vensim icon

Once the Vensim platform has been opened, the toolbar is used to construct a stock and flow or causal 
loop diagram. When completed, the diagram should appear similar to the example shown in figure 7.2. 



Figure 7.2 Completed stock and flow or causal loop diagram

After completing the diagram, enter the equations for calculating the output of each variable on the 
basis of the inputs provided by the variables that surround it. This is done by clicking the Equation tab 
and then clicking on the variable for which the equation is to be written: the equation editor will now 
pop up, as shown in figure 7.3.

Figure 7.3 Equation editing dialogue box



Write the equations for your variables, one at a time. Once equations are entered for all the variables, click 
on Check Model. If any errors have been made, these will be highlighted at the bottom of the equation 
editor. Variables with errors are also highlighted in black, as shown in figure. 7.4.

Figure 7.4 Screenshot showing variables with incomplete or incorrect equations

If no errors have been made, no variables will be highlighted on the screen and the prompt “Model/
Equation OK” will appear. The model is now ready to run simulations.

Name the model in the simulation results file name field. Now click “Simulate”. Once the simulation is 
complete, click on the output window and select the data sets for which you require simulation results. 
An example of this step is shown in figure 7.5.
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Figure 7.5 Datasets dialogue box

After selecting the data set(s), click on Load From. Simulation results can now be viewed by clicking on 
the relevant output window on the left side of the screen. For this tutorial, “change in CIS coverage” is 
used as an example. Clicking on that icon will highlight it on the screen, as shown in figure 7.6.

Figure 7.6 Highlighting a workbench variable
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We can now click on any of the output icons to view simulation results. Clicking on the Graph icon, for 
example, will call up the relevant simulation results, as shown in figure 7.7.

Figure 7.7 Graph output window

The graph displayed in the window will show the predicted behaviour of the selected variable for the 
next 22 years. That prediction is made on the basis of the historical data that have been entered into the 
model.

Figures 7.8 to 7.15 below show screenshots of the following output windows: Table, Causes Tree, Uses 
Tree, Loops, Causes Loops, Document, Document All, Causes Strip, Table Time and Runs Comparison.
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Figure 7.8 Table output window

 

Figure 7.9 Causes Tree output window
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Figure 7.10 Uses Tree output window

Figure 7.11 Loops output window
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Figure 7.12 Document output window

Figure 7.13 Document All output window



Using Vensim simulation software to assess the socioeconomic impact of climate information services 

26

Figure 7.14 Causes Strip output window

Figure 7.15 Table Time output window
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Figure 7.16 Runs Comparison output window

It is also possible to view two or more outputs at the same time. This can be done by clicking on several 
outputs one after the other. The outputs will appear on top of each other but can be viewed alongside 
each other by resizing each output window using the mouse. An example of multiple outputs displayed 
on the same screen is shown in figure 7.17.

Figure 7.17 Multiple output windows
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The SyntheSim function can be used to adjust simulation results in real time. The user can move the 
sliders located above or below each variable to the left or to the right to either increase or decrease the 
value of that variable. As shown in figure 7.18, SyntheSim values appear in red while default simulation 
values appear in black.

Figure 7.18 SyntheSim view output window

Model output validation

Model outputs have been compared with real-world data up to 2018. Many simulation outputs closely 
correspond to available real-world data. Figure 7.19, for example, shows the number of extreme adverse 
weather events that occurred between 1980 and 2015. For the period 2000–2015, the model predicted 
a flood event almost every other year, and three or four severe drought events and a number of minor 
drought events. This is consistent with data collected by the United Nations Office for Disaster Risk 
Reduction on adverse weather evens during that period.
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Figure 7.19 Flood and water scarcity indicators, 1980–2015
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8. Conclusion
This manual provides an overview of how Systems Dynamics modelling carried out on Vensim platforms 
can be used to assess the socioeconomic impact of climate information services and provides graphical 
examples of the steps to be followed and the outputs that can be obtained. It is hoped that this manual 
will help users make effective use of Vensim software.

All manuals are subject to revision, however, and users are invited to communicate any suggestions on 
how this manual can be improved to the authors.
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